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NOTE: Fully test all datalogging and associated
equipment before field installation.
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their respective owners
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SETTING UP YOUR COMPUTER

INSTALLING PROLOG

To Install Prolog, begin by inserting the CD into your computer. A splash screen
should be displayed with an option to install Prolog. If the splash screen does not
appear you may need to double click on the CD. Click on Install Prolog and the
software will guide you in setting the software up on your computer.
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THE INSTALLATION SPLASH SCREEN
LOADING PROJECTS

A project file contains all of the configuration information for Prolog to work with
your dataloggers. Your project also contains downloaded data from your
dataloggers, and specific software settings for Prolog to use. All of the information is
kept in a base folder for the project. Once Prolog is installed on your computer, you
can load any projects you may have. If you have a project CD insert it into your
computer and click on Load Packed Project. If the project is a file ending in .ppf
you can simply double click on it.
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& _Project,ppf

A PROJECT FILE



SETTING YOUR PROJECT OPTIONS

When you add a new project or run the software for the first time, the project
options form will appear. It is a good idea to check your communication options at
this time. Ensure that the communications port and baud rate are set correctly. If
you need to change your project settings at any time, the project options form can
be accessed by selecting Options from the Project menu at the top of the
program.

Project Options

Direct Communication | bodem Communication | Data F'r-:ucessing] Audio ]

Direct Commmunication:
Local COM port; | COM 1 >l

D atalogger Baud rate:; ]4EEIEI L{

Advanced Communication O ptiahs

k. Canicel Help |

THE PROJECT OPTIONS FORM



ENTERING YOUR KEY CODE

By default Prolog installs as a 30 day trial. To permanently unlock the program
select Registration from the Help menu. You then need to enter your user name
and key code to unlock the software permanently. Your user name must be entered

exactly as it was given to you.

=% Registration

Flease enteryour user name and key code:

Llser name: ]

Kew code: ] ] I

To obtain a permanent key code please contact Lakewood:
Fh: 1-858-462-9110

Fax: 1-780-450-36E7
e-mail: maili@lakewood.com

k. | Cancel |

THE REGISTRATION FORM

NOTE: Your key code is tied to your specific
user name. They will only unlock the software if
they are used together.




CONNECTING YOUR DATALOGGER TO YOUR COMPUTER

The connection from your computer to your datalogger will be made through
Lakewood System's CC-10S communications cable.

CC-10S COMMUNICATION CABLE

USING YOUR COMPUTER'S COM PORT

The CC-10S cable can be plugged directly into your computer’s serial port

COMPUTER SERIAL PORT

NOTE: Not all serial cables work with
Lakewood dataloggers. An incorrect cable could
damage your computer with certain datalogger
configurations.




USING USB FOR COMMUNICATION

If your computer does not have a serial port, a Lakewood Systems USBA (USB
Adapter) should be used to connect the CC-10S cable to a USB port.

USBA ADAPTOR CABLE

The CC10S plugs into the USBA, then into your computer. Drivers for your USBA
should be installed on windows before the cable is used.

YOUR COMPUTERS USB PORT

NOTE: Not all usb to serial coverters work with
Lakewood dataloggers.



CONNECTING YOUR CABLE TO A UL-16

To connect your cable to a UL-16 Ultra Logger, plug your cable into the unit as

shown below.

CONNECTING YOUR CABLE TO A UL-16

CONNECTING YOUR CABLE TO A CP-X

To connect your cable to a CP-X Chart Pac, plug your cable into the unit as
shown below.

CONNECTING YOUR CABLE TO A CP-X



CONNECTING YOUR CABLE TO A RX DATALOGGER

In order to connect a CC-10S com cable to an RX Unit a CAP plug must be used.

CAP PLUG

To connect your CAP plug, screw it into the connector labeled COM
(Communications) on the RX Datalogger as shown in the following pictures.

RX COM PORT



CONNECTING CAP PLUG TO RX UNIT



DOWNLOADING YOUR DATA

Lakewood Systems Prolog Software has been developed to make downloading
your data a quick and easy one-step process. Before beginning your download, first
ensure your datalogger is properly connected to your computer. Also confirm your
project options are set correctly. To begin downloading your data simply click the

Download button.

Once your download is complete, a graph will appear. Prolog has automatically
created a Lakewood Site File (.Isf). The name of the site file is displayed on the blue
bar to the right of the download button. All of the site files are saved in the site
folder in your project base folder The site file contains all the important information
pertaining to your site. It includes current site readings of your sensors, datalogger
settings, status, notepad, and most importantly your recorded data.

File Project Logger Motepad  Ser

I E Frojects I

B EE

ﬁ Download
i

Canfi

THE DOWNLOAD BUTTON

NOTE: It is important to check the condition of
your battery and datalogger memory while in the
field.




WORKING WITH YOUR DATA

The Data button allows you to view and analyze your data. Your recordings can
be observed as a chart (graph) as well as in tabular form. Your data can also be
transferred to spread sheets, reports, e-mails and other forms of documents.

WY
__ Data

THE DATA BUTTON
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Datalogger #1  Description: DEFAULT  Sample Rate: 00:00:15  Precizion: -DOUBLE-

——C TP-10KC ALGE

Qcti 2105 Qcti 305 Qcti 305 Qct 305
16:00:00 00:00:00 06:00:00 12:00:00

First Recording’ 10012/05  16:00:15 Last Recording: 10413405 143715 5

v Fetieve Data From Logger

THE DATA SECTION

ACCESSING YOUR STORED DATA

The site file created by pressing the Download button can be reopened by
clicking on the open folder icon located on the blue bar beneath the Project
button. Once your site file is opened you will have the ability to examine your data,
open it in a spread-sheet or paste it into a document.

Cpen Sike Du:uwnlu:uau:l|

CLICK ON THE OPEN SITE DOWNLOAD BUTTON TO LIST YOUR STORED SITE FILES
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WORKING WITH THE GRAPH
ZOOMING BY DRAWING BOXES
You can zoom into a specific region by holding down the left mouse button and

drawing a box from an upper left point on the graph to a lower right point on the
graph and releasing the button.

Catalogger #1  Description: DEFALLT  Sample Rate: 00:00:15  Precision: -DOUBLE-

—— C TP-10KC ALGS

18 1
it 205 it 305 Ot 305 it 305
18:00:00 00:00:00 0E:00:00 12:00:00

Flrst Recording: 1092005 16:00:15 Last Recording: 1001305 14:37:15 5

DRAWING A BOX TO ZOOM THE GRAPH

To return to the original zoomed out state, draw a box from a lower right point to
an upper left point on the graph.

Datalogger #1  Description: DEFAULT  Sample Rate: 00:00:15  Precizion: -DOUBLE-

—— . TP-10KC ALGS'

i . R s (ST S SN, SO SRS | PSR S S

Ot 305 Octi 305 Dt 305 Ot 305 Ot 305 Dot 305
06:30:00 07:00:00 07:30:00 08:00:00 08:30:00 09:00:00
First Recording 10730205 16:00.15 Last Recording: 315305 14£:37:15 5

DRAWING A BOX TO ZOOM OUT

USING THE MOUSE SCROLL WHEEL TO ZOOM AND PAN

The scroll wheel of your mouse can be used to pan and zoom the graph. Panning
can be achieved by pressing down on the scroll wheel and moving your mouse
around. Turning the wheel up and down allows you to zoom in and out of the graph
respectively.
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WORKING WITH A TWO BUTTON MOUSE

If you are using a two button mouse, panning the graph can be accomplished by
right clicking on the graph and selecting the Use right mouse button to pan
option. To restore your mouse back to the default setting you must first right-click on
the graph, then choose Use middle mouse button to pan.

ANNOTATING THE GRAPH

To add an annotation to the graph, right click on the graph and select Add
annotation. This will enable you to enter text, which will appear in a box on the
graph. The created annotation box can be moved to a desired location by clicking
and holding down the left mouse button then placing it. Annotations can also be
edited or deleted by right clicking on the annotation and selecting the corresponding
option. Annotations and graph zoom states are preserved by saving the entire site
file as a different name. All of the annotations can be cleared by right clicking on the
graph and selecting Delete all annotations.

Datalogoer #1  Description: DEFALLT  Sample Rate: 00:00:15  Precision: -DOUBLE-

—— . TP-10KC  ALGE

19_5...........,'...____._...E....._.......E........_.__:._.........._:.__._...... S

194 Ly L NP ePR ey L e
e R

1a24 - M

R L i s s gl L 2T I L R P S T e L o e i A Lt
] i : Lowvest temperature point H
T B = n USRS
187 __,___:___I_.___.__
Qcti30s Ot 305 Ot 3105 Dt 305 Dt 305 Ot 305
06:30:00 07:00:00 07:30:00 08:00:00 08:30:00 09:00:00
First Recording: 1012005 16:00:15 Last Recording, W 1305 14:37:15 5

AN ANNOTATION ON THE GRAPH

COPYING THE GRAPH TO THE WINDOWS CLIPBOARD
To copy the graph to the clipboard, click the Copy Chart To Clipboard

button. The graph is then stored as an image on the windows clipboard and can be
pasted into other applications such as Outlook, Word or Excel.

THE COPY CHART TO CLIPBOARD BUTTON
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MICROSOFT WORD WITH A GRAPH FROM PROLOG

VIEWING THE DATA IN A TABLE

The View Tabular Data button allows you to display corresponding tabular

data above your chart.

THE VIEW TABULAR DATA BUTTON
WORKING WITH THE DATA IN EXCEL

The View Data In Excel button opens your data in an Excel spread sheet. If
another program is the default viewer for comma separated variable (.csv) files that

program will be used instead.

THE VIEW DATA IN EXCEL BUTTON
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CHECKING THE STATUS OF YOUR DATALOGGER

The status of your datalogger can be checked by pressing the Config button.
The Config button displays important information about your datalogger that should
be checked every time you are in the field.

i

Confi

THE CONFIG BUTTON
CHECKING THE SUMMARY SCREEN

The Summary tab shows you the most important information about the state of
your datalogger. It displays the site nhumber, description, sampling rate as well as
current memory, battery, and clock status.

Surnrnary ] Mgmu:ur_l,l] Eattery] Elock’“‘] Input Lines] F'rogrammjng]

DEFAULT Site: 1

Unit Descriptors:

Slte Number: 1
_ Dezcription: DEFAULT
' .S.amﬁlling:
Sai‘nplé .r-ate bk sz]: 00:00:15
; -:Memur_l,l'
. Percent full:_ 17%
Drate when fulk 1041872005
. .Eiét.te.ry 2
' Mair (9v7]
Ailary {1 2\;]:'
-'Elcu:k :
' Datalogger dets: 10/13/05
Dataloﬁget tirne: 2:37-07 PM

Read Current  Configuration From Logger

THE SUMMARY TAB

NOTE: It is important to check the status of the
battery and memory when you are in the field.
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CHECKING YOUR DATALOGGER'S BATTERY

The Battery tab shows you detailed information about the datalogger's
batteries. This sheet also allows you to set your datalogger's sensors for Pulsed or
Continuous power. Some sensors require a certain amount of time to stabilize to a
correct reading. In Pulsed power mode the datalogger powers your sensor for the
specified warm-up time, takes a reading and then goes back to sleep. With
Continuous power mode the sensor has power delivered to it constantly.

Summar_l,j] Memory  Eatten ] I:I::u:k“"] [npLt Lines] F'ru:ugramm_ing]

DEFAULT Site: 1
il
tain Logger Batteny [3%]

11.34 ¥olts (BEST)
A, Senzor Batter [12 Y]
' 15.45 Volts (BEST) |

_.'.'Switcheu:l power (o sensors
“Warn up time: 0.035 Sec [ Estended delap logger

(¥ Pulzed power

i Conbinuous power

= _;__‘_‘.I'rl'._l-
Set switched power E> e

Fead Cument Configuration Fram Logger

THE BATTERY TAB

NOTE: Powering your sensors continuously
may consume much more power and could
inadvertently drain the battery if left on.
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RESTARTING YOUR DATALOGGER'S MEMORY

The Memory tab shows you detailed information about the memory usage of

your datalogger. This tab allows you to restart your datalogger and calculate the fill
time based on a restart.

LImniary £ Ebattery [ulsd riput Linez | Programming
5 Mermnomny | Batt Clock* | Input L P

DEFAULT Site: 1

temon zage:

kdemary USEdZL: 17% |

temory ‘Wraparound: Dizabled
temarn Fill Times [given normal zampling cunditiuﬁnéj :
Drate when Full: 10182005
October 2005
sun an Tue  Wed  Thu Fri Sat

25 27 28 24 3 1
i a 4 4] f T a

g 10 11 12 13 14 14
16 17 18 19 20 21 22
2 24 25 26 27 28 29
30 | 1 2 5

Calculate fill time based on restart |

THE MEMORY TAB
Pressing the Restart Datalogger button will restart your datalogger's memory.

The Calculate Fill Time Based On Restart button will tell you when the
datalogger memory will be full if you were to restart it now.

Bestart D atalogger E:> ‘

THE RESTART DATALOGGER BUTTON

Calculate fill time bazed on restart |

THE CALCULATE FILL TIME BUTTON
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SETTING THE DATALOGGER'S CLOCK

The Clock tab allows you to check and set the datalogger clock. The Set

Datalogger Clock button will let you synchronize the clock of your datalogger to
your computer’s time or let you specify a different value.

Summarg] Mgmur_l,l] Battery  Clock™

DEFAULT Site: 1

i Datalogger Clock:

Input Lines ] Frogramming

Dratalogger tirme; 2:3F-07 PM
D atalogger date; 1013405
October
Sun I MMan | Tue I wed | Thu I Fri | Sat |
1
2 a 4 ] & 7 &
k| 10 1 12 “ 14 15
& 17 12 13 20 21 22
23 24 25 2B 27 28 29
a0 H

Read Current Canfiguration From Logager

THE CLOCK TAB

Set datalogger clock

THE SET DATALOGGER CLOCK BUTTON
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CHECKING AND LEAVING NOTES ABOUT THE SITE IN
THE DATALOGGER

The Notepad button displays a section of the datalogger's memory where you
can store important notes. Information is kept in text form and usually includes notes
about the datalogger, sensors used and the site itself.

&7
Haotepad

THE NOTEPAD BUTTON

DlE |

Notes:

—Check Battery
—Check Status
-Update Motepad

Fead From Logger @ Ny

THE NOTEPAD SECTION

Wiite To Logger

There are a number of buttons which allow you to to work with the notepad. The
New, Open And Save Notepad buttons give you the capability to create a
new datalogger notepad, load a notepad file that you have saved on your computer
or save a file containing the notepad information to your computer.

0| | &

THE NEW, OPEN AND SAVE NOTEPAD BUTTONS
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The Read From Logger button reads the notepad from the datalogger’s
memory and displays the information on the screen.

Bead From Logger @

THE READ FROM LOGGER BUTTON

The Write To Logger button writes the text on the screen and into the
datalogger's memory.

: ; Wfrite To Logger

THE WRITE TO LOGGER BUTTON
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CHECKING THE CURRENT READINGS OF YOUR
SENSORS

The Sensors button will allow you to monitor current readings and change which
sensors are being used in your application.

S0Pl
e
3

—

o

Senzors

THE SENSORS BUTTON

D& &l
Analogs:
[25vOLT |
5o <
.|2.5'JIZILT | |
.|2.5'JIZILT ﬂ' |
.|2.5UIZ|LT ﬂ' |
| EEREEY |
|2vOlT ¥
Analog 8 ||TF-6 ~| 208105C |25
Strobe:
' [Counts =i (multiplier]
Display Mode:

v Automatically load senzor format if available

Show output in: 7+ Engineenng Unitz © Yoltage

% Start Monitaring

THE SENSORS SECTION

The Start Monitoring button shows the current readings of your sensors.

% Start Monitonng

THE START MONITORING BUTTON
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The sensor readings are calculated differently depending on what sensor is
selected for the channel. The sensor selection drop down menu lets you choose
which sensor is on each channel. Changing a sensor using the drop-down menu
also updates your graph in the data section.

|Analog 8 ||IIZE =l e
Chobe:- F5-15F )
=1 B imukiplien

FS-15F _inver

v dutomal TPINT-C ™ Farmat if available

THE SENSOR SELECTION DROP DOWN MENU

Prolog saves the information about which sensor is on each channel in a sensor
format file. The New, Open And Save Sensor Format File buttons give you
the capability to create a new sensor format, load a sensor format file that you have
previously saved on your computer or save a sensor format file to your computer
respectively.

rAnalogs;
nalog 1 [|250LT

280LT

THE NEW, OPEN AND SAVE SENSOR FORMAT FILE BUTTONS

NOTE: If there is a sensor format file in your
project with the same name as the datalogger
description Prolog will automatically load it
unless the Automatically load sensor file check
box is unchecked.
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CHANGING YOUR DATALOGGER'S CONFIGURATION

The Programming tab displays the current settings that are programmed in
your datalogger. This section will allow you to change the site number, description,
warm-up time and sampling rate. Inputs (sensors) can also be turned on or off in
this screen. You can change any of these settings and then apply them to your
datalogger by pressing the Program Datalogger button.

Summar_lg| Mgmnr_l,l] Eatter_l,l] Clnck"“l Input Lies  Programmming |
i
E EE Advanced programing
Urit Info.
Site Mumber: ﬁ = | Dezcription: |£fault

Sampling
Hours: |0 g Minutes: |0 %] Seconds: |15 %
v Stop when mermary ful Calculate fill ime based on restart |

Analog Channels:

YW arm up time: |,_ETBE j zec, | Ewtended Delay Datalogge
STANDARD inputs: T 2024 || 5658

Enabled A dizabled: | ||[T (| || [T | | ||}
2.5l Scale: ool |l | I ol | ol |l (el
5.0 %ol Scale: | i | | 1 | I (o

MULTIPLE*ED irputs: | 9 (100011 (12 (13 |14 |15 |16
I~ Multiplexor Enabled (T (T |\ T |7 || T || T

Strobe
[~ StobeOn  Stoberangs: | | Program datalogger E: >

THE PROGRAMMING TAB

The New, Open And Save Logger Configuration buttons allow you to
create a new datalogger program, load a program or save a program.

Summary | b em
Ialy=i= |

THE NEW, OPEN AND SAVE PROGRAMMING BUTTONS
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The Program Datalogger button sends new settings to your datalogger that

you have modified.
Frogram datalogger __

THE PROGRAM DATALOGGER BUTTON

NOTE: Pressing the program datalogger button
will restart the unit's memory.
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The recording rate of your datalogger can be changed by changing the numbers
of the sample rate. If you change the sample rate it is important to check the new

memory fill time by pressing the Calculate Fill Time button.
Calculate fill time based an restart

THE CALCULATE FILL TIME BUTTON

You may have to change the memory size drop down box on the calculate fill
time form to correspond to the memory size of your datalogger.

% Calculate fill time

kemon Size

i Hemnry; .size: B4l 4
~Memory Fill Timesz [given normal zampling conditions] ;
Tirne wher: 7:02:36 AM
Drate wher full: 10423705
: Fill tirne: 5 Days 13 Hours 40 Min. 54 Sec.

Qctober 2005
Sun han Tue e Thu Fri St
25 26 27 25 29 a0 1
2 3 4 5 G 7 g
E| 10 11 12 13 14 15
16 17 15 19 20 2 22
23 24 25 26 27 25 2
30 i 1 2 3 4 =

0K

THE CALCULATE FILL TIME FORM

Memaony Size-

temary size;

THE MEMORY SIZE DROP DOWN BOX
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WHERE TO FIND MORE INFORMATION

You may obtain more information by using either the built-in Help files or by
contacting Lakewood Systems directly.

ACCESSING THE HELP FILES

The Help files can be accessed by selecting Help from the Help menu of the
program. The help files contain detailed information that is not covered in this
getting started guide.

OBTAINING TECHNICAL SUPPORT

Technical support can be obtained by contacting Lakewood Systems directly.
Please feel free to contact us if you have any questions or concerns. The following
contact information can be used to obtain technical support:

Tel.: (780) 462-9110
Fax: (780) 450-3867
#112, 9704 39 Avenue
Edmonton AB

Canada

T6E 6M7
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